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system. Toshiba America Information Systems, Inc., strongly recommends not using radio or
television broadcasts and hereby disclaims any liability arising out of the failure to obtain such a
license.

Page 4 WARRANTIES FOR NON-TOSHIBA BRANDED THIRD PARTY PRODUCTS A valuable
element of Toshiba’s product strategy is to offer our customers a complete product portfolio. To
provide this value to our customers at the most optimal prices, we offer both Toshiba-branded
and third- party manufactured products that support our Toshiba IPedge product portfolio.
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Page 12 This page is intentionally left blank.

Page 13: Organization

Introduction This guide describes the Toshiba IP5000-series telephones and various other user
operations for applications that are integrated with the IPedge system. Organization This guide
is divided as follows: is an overview of the telephones supported ¢ Chapter 1 - The Grand Tour
by the IPedge system.

Page 14: Conventions

(Library CD-ROM), cross- references appear in blue hypertext. Related Some documents listed
below may appear in different versions on the Toshiba FYI site or in print. To find the most
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current version, check the version/date in the Documents/Media Publication Information on the
back of the document’s title page.

Page 15: Chapter 1 - The Grand Tour

* 4 line LCD with back light option ¢ Full duplex Speakerphone ¢ Headset I/F ¢ Ringing LED 20
Button IP Telephone: ¢ 4 line LCD with back light option ¢ Full duplex Speakerphone ¢ Headset
I/F * Ringing LED TOSHIBA IPedge UG 11/11...

Page 16 10 Button ADM for IP5000-series * LCD programmable key strip with back light 20
Button ADM for IP5000-series ¢ Paper Key Strip 60 Button DSS for IP5000-series ¢ Paper Key
Strip IP5522-SD, IP5531-SDL and IP5622-SD can not connect ADM/DSS. Note: TOSHIBA [Pedge
UG 11/11...

Page 17: [p5000-Series Telephone Overview

C. Softkeys Hold Button D. Programmable Feature Buttons Microphone E. Message Waiting LED
Button K. Tilt stand Microphone LED Button The fixed buttons on the dial pad help perform
standard functions quickly and Fixed Buttons easily. TOSHIBA IPedge UG 11/11...

Page 18 Microphone (Mic/Mute) button toggles between Mic and Mute. When Mic key is lit,
Mute is disabled. When Mic is pressed again and light is off, Mute is enabled on the microphone
in the telephone and the micro- phone in the handset. TOSHIBA IPedge UG 11/11...

Page 19 Hold Hold Press to place an internal or external call on Exclusive hold. If your
telephone is programmed for Automatic Hold, existing calls are automatically placed on hold
when you answer a call or make another call. TOSHIBA IPedge UG 11/11...

Page 20: Programmable Feature Buttons

Note: This feature applies to the IP5131-SDL telephone. Browser Toshiba’s IP5131-SDL with it’s
large display screen also supports an HTML browser to allow navigation on the World Wide Web
or a company'’s intranet. The phone can have a homepage setup that allows navigation to begin
just like a homepage in your internet browser.

Page 21: 4-Line Lcd Display

A plus sign + on the LCD indicates there is more data to display. Press NEXT to advance through
the information. Line 4 will display the soft keys available in idle state. Press DSPLY to switch
from the Call Forward display to the User Name display. TOSHIBA IPedge UG 11/11...

Page 22: Soft Keys

Soft Keys dynamically change their functions and label depending on the state of the telephone.
The dynamic feature associated with the Soft Key is displayed on the bottom line of the LCD
display directly above each Soft Key button. TOSHIBA IPedge UG 11/11...

Page 23: Chapter 2 - The Basics

Announce simultaneously. To adjust handset Beep Tone 1. With the handset off-hook, dial the
Beep Tone Adjustment Code #6101 (default code). You hear beep tone. 2. Press Vol ] or Vol [J
to reach the desired level. TOSHIBA IPedge UG 11/11...

Page 24: Lcd Contrast

IP5631-SDL 1. Press Hold+3+46+9 (simultaneously). Others 2. Press the softkey. BL Bright 3.
Press the softkey. 4. Enter a value of 0~3 using the dialpad. (0 = dim; 3 = brightest) 5. Press
the softkey twice. TOSHIBA IPedge UG 11/11...

Page 25: Backlight On/Off

IP5000-series telephone. The Adjustment default is normal sensitivity. 1. Press 3+6+9+Hold
(simultaneously). 2. Press 0. 3. Press Hold. 4. Press Programmable Feature Button 3 (FB3) to
toggle On/Off. 5. FB3, LED On: Lower sensitivity TOSHIBA IPedge UG 11/11...

Page 26: Telephone Terminology
LED, and turns on the Spkr and Mic LED's. When Hot Dialing is not turned on the handset should
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be lifted or Sprk should be pressed in order to make a call. TOSHIBA IPedge UG 11/11...

Page 27: Making A Call

EXTR = System Speed Dial 4 Line LCD Display Names INTR = Directory Number Names Dial =
Cancel directory, get dial tone. 2. Choose the directory you wish to access and use the dial pad
to enter the name. TOSHIBA IPedge UG 11/11...

Page 28 BOB LAWVER BRAD FISHER BILL THOMAS BRIAN SMITH ONE TOUCH ONE TOUCH
PICKUP ONE TOUCH CFAC ONE TOUCH ONE TOUCH Ext. 4227 ONE TOUCH NEXT BACK CNCL 9
Line LCD Display - Dial by Name Screen TOSHIBA IPedge UG 11/11...

Page 29: Answering A Call

Perform the same steps you normally would to answer a call: press the Spkr button, the flashing
DN button or lift the handset. Handsfree MIC setting needs to be enabled by your System
Administrator. * TOSHIBA IPedge UG 11/11...

Page 30: On A Call

LED flashes. 1. While on a call, press Cnf/Trn. The call goes on hold. Consultation Hold 2. Dial
another line. 3. Transfer the call or return to the held call by pressing its Line button. TOSHIBA
IPedge UG 11/11...

Page 31: Message Waiting

Spkr or hang up to release your telephone. Your LCD shows the extension and “MW CANCEL.”
...or dial the extension that you set the Message LED on, then press Spkr . Then press or hang
up to release your telephone. TOSHIBA IPedge UG 11/11...

Page 32: Led Indicator Details

2 pulses/second After disconnecting first call... 10 pulses/second steady Conference LEDs on the
telephone flash at different speeds depending on the Note: function performed. Flash rates can
be found under “LED Indicator Details” on page 2-28. TOSHIBA IPedge UG 11/11...

Page 33: Softipt Icons

SoftIPT Directory - Clicking this icon enables you to access the directory you create using MS
Outlook. Refer to “Using the Directory” on page 3-35. SoftIPT Configurations - Double click this
icon to open the Configuration window. This enables you to view and change SoftIPT settings.
TOSHIBA IPedge UG 11/11...

Page 34: Fixed Buttons

There are two types of LCD button functions: LCD Control Buttons and Soft LCD Control Buttons
Keys. When the Soft Key prompts appear on the LCD, the LCD Control Button just below the
prompt offers access to that feature. TOSHIBA IPedge UG 11/11...

Page 35: Configuring Softipt

When a call is made using the SoftIPT directory, SoftIPT automatically attaches the outgoing
prefix for local calls, or long- distance prefix for long-distance calls, respectively. See “Using the
Long distance prefix Directory” on page 3-35 for details. TOSHIBA IPedge UG 11/11...

Page 36 SoftIPT, through Windows, of receiving a reply message after sending a broadcast
message. Therefore, Toshiba recommends using Manual mode if SoftIPT cannot find the IPedge
by Broadcast. Network If there are multiple network adapters, select the one for SoftIPT.

Page 37 1. Go to Start > Control Panel > Mail 2. Double-click the Mail icon 3. Click the Show
Profiles... button 4. Here are all the profiles setup on your PC (see Figure on page Figure 2 Malil
Setup - Outlook TOSHIBA IPedge UG 11/11...

Page 38: Basic Softipt Functions

2. Dial the phone number - click the on-screen dial pad buttons, input numbers (asterisk key,
pound key) from PC keyboard, or use the key pad on the USB handset, if available. 3. To end
the call, go on-hook (put down the receiver or press the hookswitch button). TOSHIBA IPedge
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UG 11/11...

Page 39: Answering A Call

4. Type in the contact information, click Save and Close. Add as many entries as desired. To edit
an entry, double click on the name to open. 5. Start Soft Phone. 6. Click Directory icon. The
directory displays (see below). 7. Click on the name. The SoftIPT calls the contact. TOSHIBA
IPedge UG 11/11...

Page 40: Using Echo Canceller

To use Echo Canceller, click the Audio Setting of SoftIPT and check the Using Echo Canceller box
as shown below. Enabling Echo Canceller TOSHIBA IPedge UG 11/11...

Page 41: Chapter 4 - Feature Operations

Voluntary Account Codes are optional. They can be entered during a call and are
Voluntary Account used for tracking selected calls using Station Message Detail Report (SMDR)
call Codes (Verified/Non- detail recording option. Verified) TOSHIBA IPedge UG 11/11...

Page 42: Voluntary Account Codes
System Administrator. Advisory Message Default Code Table Msg No. Characters Displayed

Additional Digits OUT TO LUNCH IN A MEETING CALL Directory Number (e.g.,220)
BACK AT Time (e.g., 1030) RETURN ON Date (e.g., 10 20) TOSHIBA IPedge UG
11/11...

Page 43 1. Go off-hook or press your extension button to hear the dial tone. Clear Registered
Message 2. Press #412. 3. Go on-hook or press Spkr to release the line. 1. Login to the EMPA.
Display Preset Advisory Messages 2. Select System Info then the Advisory Message tab.
TOSHIBA IPedge UG 11/11...

Page 44: Alarm Notification

Automatic Callback. If the activator does not answer Automatic Callback for a predetermined
time, Automatic Callback is automatically canceled. In either case, when Automatic Callback is
completed or canceled, the ACB lamp button turns off. TOSHIBA IPedge UG 11/11...

Page 45: Background Music (Bgm)

Station Call Forward extension on your telephone to override the telephone’s System Call
Forward settings. Each extension can be independently set up to Station Call Forward to a
unique destination. You can set a Programmable Feature Button to TOSHIBA IPedge UG 11/11...

Page 46 DND mode or when you don't answer a call within a preset number of rings. -
Cancels the set Call Forward feature. Notice that ¢ Call Forward Cancel each category of Call
Forward has a different code for canceling. TOSHIBA IPedge UG 11/11...

Page 47: Call History

Incoming calls with Caller ID or ANI information can be optionally recorded Call History into a
rolling list for the station where the call is ringing. The call is placed in the list along with the
number, name (if provided), time and date of the call, TOSHIBA IPedge UG 11/11...

Page 48: Call Park

When a parked call recalls your telephone, the LCD shows the line or extension that is recalling
and the orbit number. 1. Press Park in Orbit or press your extension button + #32. Retrieve a
Parked Call TOSHIBA IPedge UG 11/11...

Page 49 2. Enter the Orbit Number where the call is parked or # for the extension from which
you are calling. You cannot use to retrieve a parked call. The extension LED flashes at the in-use
rate when the call is retrieved. TOSHIBA IPedge UG 11/11...

Page 50: Call Pickup

(on the bottom left-hand side) of a multi-button telephone. If more than one call is on hold, the
call on the telephone’s lowest button ¢ number is picked up. Ringing calls are picked up over
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held calls as a priority. TOSHIBA IPedge UG 11/11...

Page 51: Call Transfer

1. While on a call, press Cnf/Trn. Transfer A Call Directly To Vm With A Dss Button 2. Press the
DSS button programmed to the voice mail number. 3. Hang up and the caller is connected to
the VM mailbox. TOSHIBA IPedge UG 11/11...

Page 52: Call Waiting

Information 2. Use the soft keys (Next, Prev, Call or Exit). Caller ID is displayed when a call is
first answered and displays for Note: the first 15 seconds of the telephone call. TOSHIBA IPedge
UG 11/11...

Page 53: Conference Call

Only the Master can control the VM with Soft Keys. 1. While talking on an outside call, press
Cnf/Trn. You hear a dial tone. The Supervising a Tandem extension LED flashes (conference
rate). Call 2. Dial an outside telephone number. TOSHIBA IPedge UG 11/11...

Page 54 soft Key. The party that you are talking to privately (the party Drop the Split party
from a DROP which you have Split from the conference) will be disconnected (Dropped)
conference and you will rejoin the conference. TOSHIBA IPedge UG 11/11...

Page 55: Direct Station Selection (Dss)

#6091 (hear Success Tone). The LED lights steady red and DND mode is activated for that
extension on your telephone. To deactivate DND Do Not Disturb #6092 ¢ Press (hear Success
Tone). The LED lights goes out and DND mode is de-activated. TOSHIBA IPedge UG 11/11...

Page 56: Setting Dnd For Another Extension

Each station is programmed with its specific emergency ringdown destination. A station number
or a group pilot number can be specified as an emergency ringdown destination. In a private
network, the station or pilot number must be in the same network node. TOSHIBA IPedge UG
11/11...

Page 57: Message Waiting

4. Press Spkr. Your Msg LED turns Off. The Msg LED on the called telephone flashes until the
called party presses the flashing Msg button which calls you back. 5. Turn off the Message LED.
The two ways to turn Off a Message LED are: Method 1 TOSHIBA IPedge UG 11/11...

Page 58: Microphone Cut-Off

3. Press Mic or Microphn Cut-off again to reconnect to the second caller. You can toggle as often
as you choose. If you do not want the first TOSHIBA IPedge UG 11/11...

Page 59: Override

Executive Override enables you to enter an established conversation. Your Executive Override
telephone can also be programmed to block Executive Override from other telephones. To
perform Executive Override After reaching a busy station, press 3 « TOSHIBA IPedge UG 11/11...

Page 60: Paging

Station users can make page announcements to telephones. Check with your Paging System
Administrator to find out the zone numbers for various paging groups. Verify with your System
Administrator if there are sufficient vacant media resources for successful paging. To make a
Page announcement to telephones: TOSHIBA IPedge UG 11/11...

Page 61: Privacy

Your telephone may be equipped with a Privacy Release and/or a Privacy on Line button. On a
normally private telephone, Privacy Release allows other appearances of your line to join the
conversation. On a TOSHIBA IPedge UG 11/11...

Page 62: Redial

2. Set up / Store your personal Speed Dial numbers. 3. Assign names to personal Speed Dial
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numbers (on supported models). There are two ways to begin a Speed Dial Call. Making a Call
Using Speed Dial TOSHIBA IPedge UG 11/11...

Page 63 oOnly the Administrator telephone can store System Speed Dial numbers. * Web-
based User Administration Assign Station Speed Dial Names 1. Login and select Speed Dial,
then select or enter the desired Speed Dial Index and set the number and name. TOSHIBA
IPedge UG 11/11...

Page 64: Time And Date Setting (Local)

The telephone does not ring when it is being called, rather a long tone is Voice First Signalling
heard, followed by the caller's voice coming through the speaker. This method automatically
starts in a hands free mode and allows both parties to speak with each other. TOSHIBA IPedge
UG 11/11...

Page 65: Uniform Call Distribution

Login - Key is On Steady ¢ Logout - Key is Off « The Login/Logout feature is applied to the call
which terminates to UCD pilot only. Therefore, the call can terminate to agent Prime or Phantom
PDN TOSHIBA IPedge UG 11/11...

Page 66 Login - from Agent Station #6062 Logout - from Agent Station #6161 Login - Agent
Station (DN) from another station #6162 Logout - Agent Station (DN) from another sta- tion
where DN = the Directory number of the agent station. TOSHIBA IPedge UG 11/11...

Page 67: Access Your Mailbox By Phone

Once you have completed this set up process, the system notifies you there are any new
messages in your mailbox. To access the New User Setup at any time in the future, press 7 from
the main system options menu. TOSHIBA IPedge UG 11/11...

Page 68: Check New Messages

(in increments of five seconds or as programmed by the system administrator). You can also
press 5 to pause the message and 5 again to resume it (it automatically resumes after 60
seconds or as programmed by the administrator). TOSHIBA IPedge UG 11/11...

Page 69: Volume /Speed Control

This option will ring their phone rather than send a message to their mailbox. 1. Press 7 while
listening to a message or after the message has finished playing. 2. You now have a few
options: TOSHIBA IPedge UG 11/11...

Page 70: Redirect A Message

Chapter 3 - Sending Messages to learn about these delivery options. to continue, 2 to send to
additional 5. The message is now sent. Press destinations, or 7 to additional destinations with
the same comment. TOSHIBA IPedge UG 11/11...

Page 71: Erase / Delete And Retrieve A Deleted Message

Your mailbox number ¢ Your security code (password) 2. From the subscriber’s menu, press 2 to
record a message. 3. Press any key when you are done recording. Press 2 to review your
message before sending « TOSHIBA IPedge UG 11/11...

Page 72: To Mark A Message As Confidential

When you send a message as priority, you will also be provided with the option to send the
message with return receipt and/or schedule it for future delivery. See this chapter for more
information on these options and follow the prompts in the system to use these features.
TOSHIBA IPedge UG 11/11...

Page 73: To Mark A Message As Priority And Confidential

1. Call the voice messaging system and select 2 from the subscriber’'s menu to record a
message. Press any key when you are done recording. 2. Select your delivery option. 3. Select
the mailbox destination and confirm. 4. Press 2 for future delivery. TOSHIBA IPedge UG 11/11...
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Page 74: To Send A Message Using Directory Assistance

1. From the subscriber’s menu, press 2 to record a message. 2. Press any key when you are
done recording and press 1 to continue. 3. Follow the voice prompts to select directory
assistance. Many organizations use 9 but some system administrators change this key press.
TOSHIBA IPedge UG 11/11...

Page 75: To Send A Message To A Group Distribution

2. Enter in the mailbox number you wish to check and the system will play the first unheard
message you left for the recipient. 3. To delete the message press 3, to replay the message
press 1, to hear the next message press 2. TOSHIBA IPedge UG 11/11...

Page 76 This page is intentionally left blank.

Page 77: Chapter 6 - Greetings

The system will advise you whether your Extended Absence Greeting is activated or
deactivated. 2. If an Extended Absence greeting has already been recorded, you can press 1 to
activate the greeting. TOSHIBA IPedge UG 11/11...

Page 78: Deactivate Your Extended Absence Greeting

2. To listen to your name before saving, press 1. 3. To record your name, press 2. 4. To delete
your name, press 3. 5. To save your recorded name simply hang up or press to exit. TOSHIBA
IPedge UG 11/11...

Page 79: Chapter 7 - Other Messaqging Applications

2. Enter the list number you wish to make changes to, followed by # 3. To add a new member,
press 2 and the new mailbox number. The system will confirm the addition. 4. Continue entering
any additional members. Press when finished. TOSHIBA IPedge UG 11/11...

Page 80: Delete Members From A Private Group Distribution List

1. Call the voice messaging system and record a new message or forward a received message.
2. When you address the message for delivery, you have the option of inputting a mailbox
number or selecting # # for a public distribution list. TOSHIBA IPedge UG 11/11...

Page 81: Personal Options

2. If itis not already activated, press 1. You may also activate or deactivate individual schedule
lines. You will need to know the notification schedule each schedule line refers to. TOSHIBA
IPedge UG 11/11...

Page 82: Set A Wake Up Call

1. Call the voice messaging system and select 3 1 1. The system will tell you whether or not
your entire message notification is activated. 2. To activate or deactivate a specific schedule
line, press 2. 3. Enter the schedule line number 4.

Page 83: Personal Assistant

3. To activate this call-out number, press 1 or to enter a new call-out number, press 2. Once the
call-out number is activated, all calls stop ringing at your office phone and will automatically be
forwarded to your call-out number. TOSHIBA IPedge UG 11/11...

Page 84: Accepting Or Rejecting Calls At A Call-Out

You can have calls sent directly to your voicemail when you do not want your Setting up “Do not
office phone to ring. Disturb” 1. Call the voice messaging system and select 4 1 2. To deactivate
and have calls transferred back to your phone, press 1 again. TOSHIBA IPedge UG 11/11...

Page 85: Setting Up A Personal Schedule

If Unified Messaging is available in your organization all of your voicemails will Voicemails
through be accessible through your email inbox. Each time you receive a voicemail an email will
be sent to your inbox with an attachment that includes a recording of Email TOSHIBA IPedge UG
11/11...
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Page 86 Click the “Link to message” to play your message using the telephone. The following
options display. Click on the appropriate button. TOSHIBA IPedge UG 11/11...

Page 87: Chapter 8 - Fax Capabilities

3. Select File > Print from the program’s menu bar, and from the printer dialog box select the
MessagingFax option from the Printer Name drop-down. 4. The Fax dialog screen (web-based)
will open. Complete the following fax sending information. TOSHIBA IPedge UG 11/11...

Page 88: Recipient

This information will be used in the fax cover letter if you choose to send one. This section will
also show you the size (in kilobytes/KB) of your fax. « TOSHIBA IPedge UG 11/11...

Page 89: Options

To set up the internal address book you must have access to Web book Access. 1. Log into Web
Access 2. Select Mailboxes > Fax > Fax Contacts from the drop down menu. 3. From this screen
you can input new contacts TOSHIBA IPedge UG 11/11...

Page 90: Fax Options

Fax options 1. Log into your Personal Administration page. Contact your System Administrator
for the IP address and log in instructions. 2. Select Mailboxes > Fax. The following options
display : Fax Settings Fax Contacts Fax Log Fax Queue Cover Information The details for each of
the settings is explained below.

Page 91: Fax Confirmation

Displays any faxes currently being processed. Fax Queue Cover page Information (entered
when printing a fax). You can use this page Cover Information to maintain cover page
information that is used when sending a fax from your desktop. TOSHIBA IPedge UG 11/11...

Page 92: Redirect Fax Messages

4. Press 1 to send to the fax machine; press 2 to enter a different number. TOSHIBA IPedge UG
11/11...

Page 93: Chapter 9 - Call Manager Basics

It can easily interface with many popular programs (like Microsoft Outlook, ¢ Goldmine, ACT,
etc.). This allows you to dial from and “screen-pop” into these programs or the Internet /
Intranet. TOSHIBA IPedge UG 11/11...

Page 94: The Main Screen

Hides Call Manager into the system tray. Double- click on the Call Manager icon (shown right) in
the system tray to return the Call Manager to the screen. Maximize Button Used to change the
phone to/from its “Compact” view and its “Expanded” view. TOSHIBA IPedge UG 11/11...

Page 95 call Forward Key and Displays the current “PBX call forwarding” status for your
Indicator phone. Hover the mouse over this area to see the entire FWD status. Click to change
your PBX forwarding status and destination. TOSHIBA IPedge UG 11/11...

Page 96 Call Manager. The list of Shortcut keys can be found using the menu selection
Setup>Shortcut Keys. Note: The F1 key is the HELP key a can be pressed at any time to access
the Help document. TOSHIBA IPedge UG 11/11...

Page 97: Expanded View

You may use Call Notes with an IVR to attach a Customer Name, Credit Card Number, and Zip
Code to the call before you answer, saving you from asking the caller for this information.
TOSHIBA IPedge UG 11/11...

Page 98: Screen Docked Views

The Main menu screen menu item expands into an ability to Change the Login settings, an
ability to reset the phone to its default settings, access help, and check the Call Manager
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version and serial number. TOSHIBA IPedge UG 11/11...

Page 99: Shortcuts

Quick Access Toolbar. Tools on the QAT respond to Alt+1, Alt+2, etc. SCM also has “Hot Keys”
for dialing and popping up (to quickly answer calls), Hot Keys which can be set in Preferences >
Hot Keys. TOSHIBA IPedge UG 11/11...

Page 100: The Side Window Screen

25 user-programmable buttons for the user. User Programmable Buttons - A number of keys
can be easily configured ¢ by the user as Feature keys, Speed Dial keys, Call keys, User Action
keys, ACD keys, etc. TOSHIBA IPedge UG 11/11...

Page 101: Companion Application Windows

Screen Colors The Call Manager has three color schemes. To change the color of your display,
click the Color drop down and select either Blue, Silver or Black. Color icon TOSHIBA IPedge UG
11/11...

Page 102 This page is intentionally left blank.

Page 103: Chapter 10 -Using Call Manager Features

Using Call Manager Dialpad 1. Click the dialpad button to expose the dialpad. 2. Enter the
number to be dialed including a trunk access code; the call will proceed automatically once a
valid number is entered. TOSHIBA IPedge UG 11/11...

Page 104: Answering Calls

While talking on an existing call and another call rings in (not marked ¢ “Campon”), click the
Answer button or double-click on the ringing call in the Calls View Window TOSHIBA IPedge UG
11/11...

Page 105: Hangup

Calls Window onto a DSS button for immediate transfer to another station. or use the mouse to
drag and drop the call from the LCD display window onto a DSS button for immediate transfer to
another station. TOSHIBA IPedge UG 11/11...

Page 106: Call Forwarding

3. Enter a Destination for the forwarded calls. 4. Click Save to compete the setting. To Clear Call
Forwarding 1. Click the. button 2. Choose <None> from the pull-down listing. 3. Click Save to
remove the previous setting. TOSHIBA IPedge UG 11/11...

Page 107: Status Messages And Dnd

5. Click the Save button when done. The status message will appear on the DSS keys
throughout the system. Turning Off DND or Message Only 1. Click the button to bring up the or
Status Message window. 2. Click the Msg Off radio button to remove the Status Message.
TOSHIBA IPedge UG 11/11...

Page 108: Viewing Extra Call Information

ACD queue; the caller could define a Preferred Agent by entering an agent’s ID into the
Preferred Agent Information field. When the call is transferred this information is available to be
used by the ACD application. TOSHIBA IPedge UG 11/11...

Page 109: Call Center Features

3. The ACD Key will display the number of ACD groups the extension is logged into and the total
number of ACD groups you are a member. To Log Out 1. Highlight the group name(s) in the left-
hand box and click the >>Log Out button. 2. Click Done when finished. TOSHIBA IPedge UG
11/11...

Page 110: Changing Agent Status

1. Click Set WrapUp button. 2. Click Done. The Set WrapUp button is NOT available on all
installations. Note: To End WrapUp 1. Click the ACD Status button. 2. Click the End WrapUp
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button. 3. Click Done. TOSHIBA IPedge UG 11/11...

Page 111: Preferences

To access Preferences click on Preferences tab. The settings in Preferences are divided between
four tabs each defined below. Depending on your configuration you may not be able to change
the Note: Preferences, in which case you should check with your System Administrator.
TOSHIBA IPedge UG 11/11...

Page 112: General

When checked, KeyTips will be disabled, allowing you to use the ALT key without them popping
up. Enable Call Logging - To have Call Manager collect and display Call Call History ¢ History,
Call Logging must be enabled. TOSHIBA IPedge UG 11/11...

Page 113 static Information Fields - These fields will have a fixed area within the Call » Notes
window for the information to be displayed. You have the ability to Add, Change an existing or
Remove any field. TOSHIBA IPedge UG 11/11...

Page 114 preferences screen with the following options: Enable Outlook Integration - This
main option enables/disables the ¢ Outlook Integration features. This must be checked for any
Outlook features to work. If you're not using Outlook, then this should be disabled. TOSHIBA
IPedge UG 11/11...

Page 115 outlook Phone Link - With the Outlook Link application installed, click the * Setup
button to access the Setup Configuration for Outlook Link. For details on setting up Outlook Link
see the Application Note “Screen Pop Outlook”. TOSHIBA IPedge UG 11/11...

Page 116: Dialing Tab

Home Area Code - Your local area code should be defined here. This is ¢ used only when you
choose to use the Local Dial Plan. TOSHIBA IPedge UG 11/11...

Page 117 optionally, the label can be changed to meet your needs. Call Results - Enable the
Action button and select the Action to be performed ¢ when the button is pressed. Optionally,
the label can be changed to meet your needs. TOSHIBA IPedge UG 11/11...

Page 118 if you chose to use the Local Dialing Plan, you need to create a dialing plan. If you
chose SERVER Dial Plan, then you should check with your System Administrator if you have
questions. TOSHIBA IPedge UG 11/11...

Page 119 Add+1 - Check the box if you need to dial a leading 1 before the number for « calls
within your Home Area Code. Dial Area Code Plus the Number - Check the box when the home
area code ¢ is also to be dialed. TOSHIBA IPedge UG 11/11...

Page 120 Dialing plans can become complex. Use these boxes to enter different Test a
Phone Number telephone numbers and check to see the number that will be dialed. The dialed
number should be identical to what you need to dial when using your phone. TOSHIBA IPedge
UG 11/11...

Page 121: Docking Tab

Once you've changed the screen-docking settings, the new settings will Note: not be used until
the Call Manager is ‘undocked’ (if it's already screen- docked) and then re-docked. TOSHIBA
IPedge UG 11/11...

Page 122: Advanced Tab

Technical Support for debugging problems encountered. The TAPI Service Provider should not
be changed unless your System Administrator has instructed you to update the settings for
finding Net Server for your application. TOSHIBA IPedge UG 11/11...

Page 123 Hostname - Enter the name of the Server PC where Net Server resides. * Use
Remote Access Port - Check this box only when connecting remotely through the Internet.
When connected locally through your LAN, do not check this box. TOSHIBA IPedge UG 11/11...
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Page 124 “send Directly to FTP Site”. As an option, when direct Internet access is not
available from that PC, the files can be zipped into smaller files, saved on your PC in your Local
Settings folder, typically “C:\Documents and Settings\<user name>\Local Settings\Application
Data\Toshiba\Call Manager\Zip"”. These files can then be e-mailed to. TOSHIBA...

Page 125: Setting Up Hot Key Dialing & Popup

Many applications use various “hot keys” or keyboard shortcuts. These Note: keys are defined
in advanced settings that your administrator can change if you encounter a conflict with
another application. See “Call Manager System Administration Manual” for details. TOSHIBA
IPedge UG 11/11...

Page 126: Skin Editor

Title Bar - change title bar logo to another image file. Supported image ¢ formats are PNG, BMP,
JPEG, GIF. Application Menu - change the application menu logo to another image ¢ file. It
supports similar file formats as those of Title Bar. TOSHIBA IPedge UG 11/11...

Page 127: Skins Files

With the Skin loaded to be deleted, click the Delete icon. Click Yes in the dialog To Delete a Skin
box to confirm the action. The system should have at least one skin; deleting the last skin will
be rejected. TOSHIBA IPedge UG 11/11...

Page 128: The Skin Editor

These settings can be found in Preferences tab > General > Extra Call Information. Right-click
on the LCD area to bring up the menu options: Change background color ¢ Change Top Line
Text color « Change High Priority Text Color « Change Medium Priority Text Color « TOSHIBA
IPedge UG 11/11...

Page 129: Insert Your Logo Into The Skin

Reset: Click this button to reset to the default colors for the specific ACD « status. Click Hide
Colors when done.Finish by Saving your Design ¢ Use the Save or Save As commands to save
your design before exiting. See ¢ above for details. TOSHIBA IPedge UG 11/11...

Page 130: Email Skins

To send the skin using email, click on the email Email skins skin button (shown right). A
Microsoft Outlook message dialog box displays (shown below). Email skins Enter the appropriate
address(s) to send the skin. Microsoft Outlook is required when using this function. TOSHIBA
IPedge UG 11/11...

Page 131: Tab Settings

Update Tab tooltip of each tab in your tab view. The 'Name' or 'Tooltip' can be changed by
clicking in the cell and typing.Use the Up and Down buttons to move the tabs appropriately,
then click OK. TOSHIBA IPedge UG 11/11...

Page 132: Delete Tab

Browser tab the browsing history may be lost, since deleting a web browser tab and adding a
new one always starts on a new blank page. Click the revert button to bring all the companion
applications back to the Revert main window as tabs. TOSHIBA [Pedge UG 11/11...

Page 133: Chapter 12 -Buttons

/ undock button on the left. You can create tabs of more buttons. There are 8 banks with a total
of up to 64 buttons each. Each Buttons application can be assigned to one of these TOSHIBA
IPedge UG 11/11...

Page 134: User Programmable Keys

Selecting an Action from the pull down listing will present additional parameters needed to
define the choice. Details for each Action follow this procedure. TOSHIBA IPedge UG 11/11...

Page 135 0~9 and * and # digits. You can include commas to insert a 2- second pause in the
dial string, i.e., setting up a key to call V-mail (x2502) and logon to a mailbox (1000 with
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password 12345) then enter “2502, *1000,12345"”. TOSHIBA IPedge UG 11/11...

Page 136 Key window. Some of the features listed are dependant upon Call Manager System
Administration settings such as the Auto Call Record/Tracer Recording features, which only
appear when the System Administrator enables those items. Others are dependant upon the
PBX used by Call Manager. TOSHIBA IPedge UG 11/11...

Page 137 Actions that have been defined will be available in the pull down list. Keys Click to
view the actions list to add/edit actions To create a new action, go to the User Actions section,
click the View/Change action button on right (shown above). The following screen displays.
TOSHIBA IPedge UG 11/11...

Page 138 3. Select the contact from your directory, as it is shown in the little popup on the
side. This will set the label for you. You can then change the colors and edit the name for easy
identification. TOSHIBA IPedge UG 11/11...

Page 139 “projects” Excel spreadsheet by simply setting the “Program or Document
Filename” to: PROJECTS.XLS. Program unused keys by simply dragging phone numbers or
feature codes from Creating Keys using other programs. Some examples include: Drag & Drop
TOSHIBA IPedge UG 11/11...

Page 140 Drag a Contact from Microsoft Outlook to a key to create a Speed Dial * button
Drag a call from the Call History to create a Speed Dial button ¢ Drag an entry from the
Contacts application to create a Speed Dial button *« TOSHIBA IPedge UG 11/11...

Page 141: Chapter 13 -Actions

User’s Local Settings Call Manager folder. Thus, it is wise to save new actions by exporting the
action for backup (see “Exporting Actions Importing Actions). TOSHIBA IPedge UG 11/11...

Page 142: Attach Account Code

(typically the 'Main Listed Phone #') before they press SAVE to export the information to the
centralized database. Path & Filename - Enter the complete path name for writing the exported
* file or browse to find the path. TOSHIBA IPedge UG 11/11...

Page 143: Log Info To File

12/02/04 16:28 In 1027 949-853-3351 Katz Yamag Yes This action will lookup the phone number
in Microsoft Outlook and then selectively Lookup in Outlook opens a contact, creates a new
contact, or adds a journal entry. TOSHIBA IPedge UG 11/11...

Page 144: Minimize Phone Screen

Name - Enter a name for the caller to be used as the Caller ID name. ¢ This replaces an existing
name or adds a name, if blank. Account # - Enter an account code for the call. This replaces an
existing * number or adds a number, if blank. TOSHIBA IPedge UG 11/11...

Page 145: Play Wav File

Works with Netscape Navigator and Microsoft Internet Explorer. URL - Enter the complete URL
name for the Web site to be opened in your browser. The URL can contain Action Variables to
make the lookup use call information. TOSHIBA IPedge UG 11/11...

Page 146: Pop Internal Web Browser

This action uses the specified tab as the parent window. URL (Paraml) - Enter a URL or other
Paraml parameters as indicated in ¢ the table below. The URL can contain Action Variables as
part of the entry. TOSHIBA IPedge UG 11/11...

Page 147: Popup Call Info Screen

Standard Call Information window Popup Info Screen Type - Choose either Standard Info or
Extra Info. When ¢ Extra Info is selected, choose when the popup will occur: Always, Any Info
Attached, or Any Priority Info. TOSHIBA IPedge UG 11/11...
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Page 148: Popup Phone Screen

Parameters - Enter any additional parameters that may be accepted as ¢ part of the command
line to startup the program. The example above uses Outlook to pop open a “sticky note” with
data and time recorded. TOSHIBA IPedge UG 11/11...

Page 149: Send Dde Msqg

Run Program and Program EXE - If the target program is NOT found to be ¢ running, you can
have the action attempt to automatically start the program. TOSHIBA IPedge UG 11/11...

Page 150: Send Keystrokes To A Program

Note: command-line parameter “/calls.txt” to be used. The result is that the file “calls.txt” will
open, if not open, and popup with the cursor at the end of the file allowing additional entries to
be made. TOSHIBA IPedge UG 11/11...

Page 151 {F7} Help {HELP} {F8} Home {HOME} {F9} {INS} {F10} Left Arrow {LEFT}
{F11} Num Lock {NUMLOCK} {F12} Page Down {PGDN} {F13} Page Up {PGUP} {F14} Right
Arrow {RIGHT} {F15} Scroll Lock {SCROLLLOCK} {F16} Spacebar Control Shift TOSHIBA IPedge
UG 11/11...

Page 152: Set Phone Status Message

Custom 2nd Line - Optionally enter a second line to display on the lower ¢ line of the phone’s
display message. Action Variables may be used including the time variable plus ‘x’ Note:
minutes to set a current time plus 60 minutes in the example above. TOSHIBA IPedge UG
11/11...

Page 153: Set Phone Forwarding

(Immediate, Busy, No Answer, Busy/No Answer, or Off) and the destination. Choose Forwarding
- Select from the drop down list the forwarding action to ¢ use. Destination - Define the number
for the destination of the forwarding. This is ¢ left blank when using Forwarding Off. TOSHIBA
IPedge UG 11/11...

Page 154: System/Pbx Command

Recommend using Transfer Call action. Recording Option When Recording is active on Call
Manager. RECORD RECORDBKMAKR Substitute your bookmark text for “Text” “Text
RECORDSTOP ACD Option When ACD is available on some PBXs. ACD HELP ACD PU SET
WORKUNITS TOSHIBA IPedge UG 11/11...

Page 155: Transfer Call

Voice mailbox, or to an outside phone number (i.e. 9,4969040). Transfer To - Enter an extension
number or outside number to be called. « Transfer Mbox - Enter a mailbox number if going to a
Voice Mail number. « TOSHIBA IPedge UG 11/11...

Page 156: Action Variables

Action Variables replaces the variable token code with the appropriate value when the action
executes. For example, %P becomes ‘4804969040" when you receive a call from Toshiba. Refer
to the table below for call variables and their values. Call Variables...

Page 157 ‘x or leftmost characters. Insert -x to restrict the variable value to the last ‘x’ or
rightmost characters. For example, to pass the first 8 characters of the Calling Party Name,
enter: %+8N. To send the last 4 digits of the Calling Phone Number, enter: %-4P. TOSHIBA
IPedge UG 11/11...

Page 158: System Variables

LUNCH message and a second line of UNTIL &U+'30’. If this action is used at 11:55 AM, then the
resulting message on Call Manager is OUT TO LUNCH UNTIL 12:25 PM. Examples for Text
Reader/ Announcer: Speak Reminder: SPEAK,"Reminder,%OR("SUBJ"),Starting
%OR("DIFF")",&V1,&V2 Speak Appointment: SPEAK,"Appointment,%O0C("SUBJ"),Starting
Now",&V1,&V2 Announce Call: CA,%T,&F,"%N",%H,&V1,&V2 TOSHIBA IPedge UG 11/11...
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Page 159: Exporting Actions

This file is exported into the user’s application data folder (typically, “C:\Documents and
Settings\<user name>\Local Settings\Application Data\Toshiba\Strata Call Manager”). In order
to identify the file more easily you may want to user Explorer to rename that file to something
more appropriate (i.e.

Page 160: Testing Actions

Handler you may want to open the Main Menu lcon > Setup > Advanced > Show Events screen
(see your System Administrator if you do not have the Advance menu item) to see what is
actually occurring when that action is being used. TOSHIBA IPedge UG 11/11...

Page 161: Chapter 14 -Personal Call Handler

Then you can create a Personal Call Handling Rule and choose which event will trigger the
action(s) and then refine this by setting the conditions for when the trigger will occur. TOSHIBA
IPedge UG 11/11...

Page 162: Creating Personal Call Handling Rules

1. Click the Personal Call Handler icon > Personal Call Handler tab. The following screen
displays. To Delete a Rule Highlight the rule to delete and click Delete. « To Add or Change a
Call Handling Rule 1. Click the Add button TOSHIBA IPedge UG 11/11...

Page 163 For the last two options, enter a specific number in the box including wildcard
characters when needed. See Like Matches and Unlike Matches for use of wildcards. TOSHIBA
IPedge UG 11/11...

Page 164 see Like Matches and Unlike Matches for use of wildcards. Call Disconnect -
Whenever a call leaves the phone (whether the caller ¢« hung up or the call was transferred or
forwarded). TOSHIBA IPedge UG 11/11...

Page 165 Account Code - Select the account code type to be used. For the last two options,
enter a specific number in the box including wildcard characters when needed. See Like
Matches and Unlike Matches for use of wildcards. TOSHIBA IPedge UG 11/11...

Page 166 Account Code - Select the account code type to be used. For the last two options,
enter a specific number in the box including wildcard characters when needed. See Like
Matches and Unlike Matches for use of wildcards. TOSHIBA IPedge UG 11/11...

Page 167 For the item with a message to match, enter the beginning characters of the
message. See Like Matches and Unlike Matches for use of wildcards. ¢ Affected Phone - Select
whether this rule will be based upon My Phone or My Secondary Extension. TOSHIBA IPedge UG
11/11...

Page 168 See Like Matches and Unlike Matches for use of wildcards. Outlook Calendar may
also send a ‘Tentative’ status setting which is Note: treated using the ‘Any’ setting. TOSHIBA
IPedge UG 11/11...

Page 169: Like Matches

To Export Call Handler Rule - Click the Export Rule to create a.RUI file in the PC user’s
“C:Document and Settings\Application Data\Toshiba\Strata Call Manager” folder. Each rule
created can be saved as a file for backup purposes and copying to another PC to allow the same
rule to be used by other users.

Page 170: Export Rules

(i.e. 2.ACl). The file is exported into the user’s application data folder (typically, “C:\Documents
and Settings\<user name>\Application Data\Toshiba\Strata Call Manager”). In order to identify
the file more easily you may then want to user Explorer to rename that file to something more
appropriate (i.e. PLAYBELL.RUI).

Page 171: Chapter 15 -Using Microsoft Outlook

Open Contact or Add Contact or Add Journal options. Now, when a call is ringing on your phone,
a small "User Options" window will pop up showing the Contacts that match the phone number
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(if any) as well as buttons that let you manually "Open/Add Contact" or "Add Journal". TOSHIBA
IPedge UG 11/11...

Page 172: While On A Call

Handler rule using a trigger to run the "Popup Call Info Screen" action (i.e. whenever you
answer a call). A feature may also be available to you, depending upon support for your system,
to divert the call (Divert Call) to another destination. Contact Match found Contact Match not
found TOSHIBA IPedge UG 11/11...

Page 173: Integrating With Outlook Calendar

Status Message can be modified Message to become something very simple to allow for the
Subject to become the predominant part of the message. The second Action will clear the
message when the appoinment ending time is reached. TOSHIBA IPedge UG 11/11...

Page 174: Create Personal Call Handler Rules

Calendar Status including ‘Free’ and the clear command would be followed by a command to
set the message, thus the message would never clear. The final set of PCH rules should be in
the order of items 3 and 4 in the PCH Rules screen. TOSHIBA IPedge UG 11/11...

Page 175: Chapter 16 -Using Companion Applications

The default search method is “Starts with”, where only entries starting with the same letters as
the search criteria will be shown. Other search methods are available, and can be accessed with
the button to the left of the search area. Search criteria button Search criteria TOSHIBA IPedge
UG 11/11...

Page 176: Cix Directory

Enable the Hide Names option ¢ to enable the filter. To Add a Filter Entry - Place ¢ the cursor in
the text box. Type in the characters to be filtered and press Enter or click the Add button.
TOSHIBA IPedge UG 11/11...

Page 177: Personal / Speed Dial Directory

Groups” is personal and you can create their own. “System Groups” applies to all and only a
user with “Admin” right can create and change the group entry. To manage the Presence
Viewer 1. Click the Group tab assigned for the Presence Viewer. TOSHIBA IPedge UG 11/11...

Page 178 2. Right click on an entry for options to either call, chat, broadcast, edit or delete
group. 3. When you select Edit group, the following dialog box displays. Use the double arrow
buttons to add or remove users from the group (shown right). To use view Presence Status
TOSHIBA IPedge UG 11/11...

Page 179 Ipedge Using Companion Applications The Presence status shows the status of
users, such as Idle, Busy, etc. Right click the member to start Chat or call the person through
Call Manager. TOSHIBA IPedge UG 11/11...

Page 180: History

Call History logs the current Account Code when the call leaves the Call Manager extension.
TOSHIBA IPedge UG 11/11...

Page 181 Lookup in Outlook - Look up the telephone number in Microsoft Outlook and open
any matching Contact. ¢ Listen to Call - When the Tracer Integration is provided, this button
provides a link to Replay to allow the recording to be played back. TOSHIBA IPedge UG 11/11...

Page 182 Account Codes - Choose “All” for calls with any or no account code. Use the
“Starting with” option to limit the search to calls matching or starting with a specific account
code. For example, ‘123’ returns calls with account codes 123 and 123xxx. TOSHIBA IPedge UG
11/11...

Page 183 Clear Filters Button - Resets all filters to ‘Off”. Press Search to re-load all Call «
History record. Or, select new filter settings and start a new Filter search. Cancel Button -
Closes the filters screen with no update to the “Calls ¢ Display”. TOSHIBA IPedge UG 11/11...
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Page 184: Acd Viewer

The ACD actions can be used to Log In / Log Out to/from ACD groups. Going temporarily
unavailable and an ability to end wrap times can be part of the features available. Additional
Call Center features are possible using User Programmable buttons. TOSHIBA IPedge UG
11/11...

Page 185: Logging In Or Out

1. Right click My Status once you have expanded the views in the ACD Viewer pane. The
following ACD Agent Status window will appear: To Make Agent Unavailable 1. Use pull-down list
and choose a reason. 2. Click the Make Unavailable button. 3. Click Done. TOSHIBA IPedge UG
11/11...

Page 186 The ACD View has many configuration options that allow you to customize it to
your needs. When the ACD Viewer is operating and visible you can configure it's settings by
clicking on the wheel icon in the upper left hand corner and selecting the Setup menu. TOSHIBA
IPedge UG 11/11...

Page 187: Acd Group Status

ACD Group Status button will turn Yellow. The available conditions are: Calls Waiting > 'x’ calls
Longest Waiting Call > 'x" Secs Waiting Calls / Agent > 'x" % TOSHIBA IPedge UG 11/11...

Page 188: Notifications

Show the ACD Viewer if it is hidden on your screen when a Status is met. This will bring the Call
Manager and the ACD Viewer to the forefront of your screen. Click Save to save all changes.
TOSHIBA IPedge UG 11/11...

Page 189: Cm Lcd

% % - Percent Sign %Q - # of Waiting Calls %Z - Calls per agent %Y - # of Agents Available %C
- Total Calls %X - Total Agents %G Urgent Message %Q Waiting Calls: Longest Waiting Call: %L
TOSHIBA IPedge UG 11/11...

Page 190: Miscellaneous

Yellow (Warning) = Default: one call waiting and at least one agent logged in. But this threshold
is configurable. Red (Urgent) = Default: Two or more calls waiting OR no agents logged-in and
available. But this threshold is configurable. TOSHIBA IPedge UG 11/11...

Page 191 3. The last line in the expanded view is the “My Status” line. This not only shows
your personal status in this ACD group but allows you to change your status and perform
functions using right-click menus as described in the following section. TOSHIBA IPedge UG
11/11...

Page 192 Request Help Call to Supervisor - while you are on an ACD call, you can ¢ use this
to initiate a request for a help call to a supervisor in the ACD group. This is further explained
below. TOSHIBA IPedge UG 11/11...

Page 193: Reguesting Supervisor Help

If the supervisor accepts your request for help you will receive notification. If the supervisor
denies your request you will receive a rejection notification. If a supervisor or supervisors do not
respond to your request you will see the following: TOSHIBA IPedge UG 11/11...

Page 194: Chat

Using Chat Messaging communicate with that person, how to answer an incoming Chat
communication, and how to send Broadcast messages. To Access Chat - Click the Chat tab on
Call Manager. The following ¢ screen will display. TOSHIBA IPedge UG 11/11...

Page 195 2. You must respond within 30 seconds to this message or the caller will get a
message “User did not respond. However, the 30 seconds setting is configurable. 3. Ongoing
conversations follow those described in To Send a Text Messageand Options During a Chat
Conversation. TOSHIBA IPedge UG 11/11...
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Page 196 From the Edit menu, click either Copy or Copy All to copy the highlighted or all of
the conversation to the Windows Clipboard for pasting into another application. To End the
Conversation ¢ Press the Close button to end the conversation. TOSHIBA IPedge UG 11/11...

Page 197: To Send A Broadcast Message

1. To initiate a broadcast message, double click on any group name in the Chat Window and
click on the Broadcast icon or Right click on any group name or select Broadcast. 2. Enter a
message into the Message box. TOSHIBA [Pedge UG 11/11...

Page 198 NoteBe aware that when using the "Chat Back" option sending to a group of
people, all recipients will have the Chat back option and if everyone responds, it could result in
a large number of simultaneous chat calls back to you. 5. Click Send. TOSHIBA IPedge UG
11/11...

Page 199: Chat Feature Operation

Available” along with any return message they provided. If they didn’t setup a return message,
the text “Do Not Disturb” will be shown. To Clear Do Not Disturb To Clear the DND Status -
Clear the DND checkbox.. * TOSHIBA IPedge UG 11/11...

Page 200: Response Buttons

Send Text Message Immediately - Check the box if you are sending text and you would like to
send it immediately, without clicking on the Send button. ¢ Click OK to save the changes you
have made to your Response Button. TOSHIBA IPedge UG 11/11...

Page 201: Personal Groups

To Delete A Personal Group To delete a group, right-click the group in the Chat List and choose
the Delete Group option. A confirmation box will appear and needs to be affirmed before the
group is actually deleted. TOSHIBA IPedge UG 11/11...

Page 202: Whiteboard Operation

Print - prints the whiteboard ¢ Exit. * Similar to the above, you can use the Edit menu to cut,
copy, edit, paste, delete, clear and clear highlighting. The View menu contains Chat Box,
Canned Replies, and Whiteboard. TOSHIBA IPedge UG 11/11...

Page 203: Whiteboards Setup

The screen opens to a “Save” window to allow you to choose the file name and Save As...
location for the file to be saved. The default location is under your “...Documents and
Settings/<user name>/Local Settings/Application Data/Toshiba/Strata Call Manager”. The Chat
application Setup menu provides access to the Whiteboards...

Page 204: Configuring Chat

Chat beep each time a new line arrives into the conversation. Click Test to verify operation. ¢
Timestamp Each Line - Check the box to show a time stamp Message Box each time a new
message is received. TOSHIBA IPedge UG 11/11...

Page 205 Send button. Once a communication channel is established, you just click the
Response Button with the message you want to send. ¢ Define the Number of rows to create
response buttons. TOSHIBA [Pedge UG 11/11...

Page 206 «Send Text Message Immediately - Check the box if you are sending text and you
would like to send it immediately, without clicking on the Send button. Click OK to save the
changes you have made to your Response Button. * TOSHIBA IPedge UG 11/11...

Page 207 Save As Local Machine Data - Click to enable this option if the settings are to apply
to all users of this PC. « Save As Current User Data - Click to enable this option if the settings
are unique for each user of this PC. TOSHIBA IPedge UG 11/11...

Page 208: Interfacing With Other Programs

These types of operations are supported by a DDE Command interface. This section defines the
format for the DDE Command Interface, its supported commands with examples with how they
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can be used. TOSHIBA IPedge UG 11/11...

Page 209: Format Of The Dde Command Interface

2. Choose a key on Call Manager, right-click and select Change Key. Name the key, choose the
colors, and select a type as User Defined Actions. Select “Visitor Waiting” from the list of actions
and Save. TOSHIBA IPedge UG 11/11...

Page 210 2. Choose a key on Call Manager, right-click and select Change Key. Name the key,
choose the colors, and select a type as User Defined Actions. Select “Notify Jan - Abusive Call”
from the list of actions and Save. TOSHIBA IPedge UG 11/11...

Page 211 in DDE Message enter: DND,ON,”In Meeting Until &U+'60"" We are using the same
time parameter used for setting Call Managers Note: DND which uses another User Defined
Action that also includes &U="60" to set the time to 60 minutes from now. TOSHIBA IPedge UG
11/11...

Page 212 1. In Chat a Personal Group is created containing the members of <Tech Support>.
2. In Call Manager create a User Defined Action using the type Send DDE Msg and name it
appropriately. In App Name|Topic enter: MSGPOP|SYSTEM TOSHIBA IPedge UG 11/11...

Page 213 calendar Reminder event occurs and the Subject matches Group Meeting. This
trigger will result in the action Group Meeting Broadcast to be taken. The assumption is the
Outlook meeting reminder is provided 15 minutes prior to the scheduled meeting. TOSHIBA
IPedge UG 11/11...

Page 214: Dialer

Using your mouse, you can resize and reposition these headers to customize your viewing area.
This area shows each call that is either (1) yet to be placed or (2) that has Calls Display Area
already been completed. The available columns include: TOSHIBA IPedge UG 11/11...

Page 215: Functions

Lookup in Outlook - lookup this number in Microsoft Outlook and open the ¢ matching contact.
Print Listing - print a listing of all entries shown in the calls window. The ¢ position and width of
the columns can be changed to format the printout as desired. TOSHIBA IPedge UG 11/11...

Page 216: Sorting Entries

Okay will place the call back into the list. As was done in the Ready to Dial screen, an optional
“User-defined” button can be provided with an action to be performed at the end of the call.
This TOSHIBA IPedge UG 11/11...

Page 217: Adding Calls To The Dialer

Any time can be entered or any elapsed time frame can be entered. The pull down list shows
some common elapsed times for placing the call. The call record will need to be enabled to be
dialed at the appointed time. TOSHIBA IPedge UG 11/11...

Page 218 Drag-and-Drop MS Excel file In Microsoft Excel it is quite easy to create and keep a
list of desired contacts and add them into the power dialer. In MS Excel simple create a
spreadsheet TOSHIBA IPedge UG 11/11...

Page 219 Note: Alternatively, if you save this file from MS Excel directly into the
“.\PDimport” sub- folder of Call Manager the entries will be automatically imported into the
power dialer . TOSHIBA IPedge UG 11/11...

Page 220: Configuration Settings

For example the user may want to set his phone into “Do-Not- Disturb” mode to stop all
incoming calls but still continue using the power dialer to place outgoing calls. Note: On some
phone systems the Call TOSHIBA IPedge UG 11/11...

Page 221: Adding Action Buttons To Ready To Dial And Results Screens

“Results” screens in Dialer. To setup these buttons, go to the Call Manager main Ready to Dial
menu select Setup then Preferences, go into the Dialing Tab. Under the Dialer, and Results
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enable either or both of the “Action” buttons and select the Action to be performed Screens
TOSHIBA IPedge UG 11/11...

Page 222: Advanced Topics

The Dialer will automatically import any file in the above-described format if Automatic Imports
the file is (1) named with ".TXT" suffix and (2) saved into the “\PDimport” sub-folder in the Call
Manager folder. Once the file is imported, it will immediately be deleted. TOSHIBA IPedge UG
11/11...

Page 223: Buttons

Feature Code ¢ Speed Dial * System/PBS Commands ¢ User Defined Actions ¢« ACD keys ¢ DSS
Extension Key * Web Key ¢ Run Program ¢ For more information, refer to Chapter 4 - Buttons.
TOSHIBA IPedge UG 11/11...

Page 224: Web Browser

The Call Manager Web Window is based on Microsoft Internet Explorer. You must have Internet
Explorer 6.0 or higher installed on the PC. Click the setup icon to set Home URL and the tools to
display in the toolbar (home, stop, refresh, go back, go forward, URL). TOSHIBA IPedge UG
11/11...

Page 225: Chapter 17 -Enterprise Manager Personal Administration

Your System Administrator can assign different User levels. Prerequisites Check with your
System Administrator your user level (Normal or Super ¢ User). Log in path/URL for the Web. ¢
Security Code (password) - By default password assigned by your System ¢ Administrator.
TOSHIBA IPedge UG 11/11...

Page 226: Log In

Security Code/ 2. Check “Change Password”. Password 3. Enter a password in the New Login
Password field confirm it. 4. Click the Save icon. Click on Log Out at the right corner of the
screen. Log Out TOSHIBA IPedge UG 11/11...

Page 227: Home

Set Distinctive ringing patterns ¢ Assign new keys or change keys ¢ Change button labels °
Change the display name ¢ List your name in the directory ¢ Turn Do Not Disturb (DND) on or
off « TOSHIBA IPedge UG 11/11...

Page 228: Keystrip Labels

Assign and Submit a button as a One Touch button. Once the One Touch button is created,
double click the button to enter the programming dialog box. Blank - Clear button assignment.
* TOSHIBA IPedge UG 11/11...

Page 229: Dnd Activating

3. Enter the digits or special buttons for the function to be dialed. You can include the following
in the dial string: Dial pad digits 0~9.To program special characters, see * Table 9 on Page 226.
* A maximum of 32 characters. TOSHIBA IPedge UG 11/11...

Page 230: To Use A One Touch Button

- gets new dial tone on the PDN - code for All Call Page which allows the user to page the
location of the orbited call. On your telephone, press the labeled One Touch button. To Use a
One Touch Button TOSHIBA IPedge UG 11/11...

Page 231: Ring Tones

1300/1780 Hz 1 sec. On, 3 sec. Off, repeat 1300/1780 Hz 1 sec. On, 1 sec. Off, repeat 860/1180
Hz 0.5 sec. On, 1300/1780 Hz 3 sec. Off, repeat 860/1180 Hz 0.5 sec. On, 1300/1780 Hz 1 sec.
Off, repeat TOSHIBA IPedge UG 11/11...

Page 232: Settings

1. After you have entered the settings in the parameters. 2. Click the Save icon. Hover over the
bubbles located above the parameters to read the Note: flyover text for information to be
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entered in each field. TOSHIBA IPedge UG 11/11...

Page 233: Call Forward

To set up Station Call Forward 2. Enter the appropriate fields. Hover over the bubbles located
above the parameters to read the flyover Note: text for information to be entered in each field.
3. Click the Save button. TOSHIBA IPedge UG 11/11...

Page 234 Note: If Direct Line Call Forward is activated on you telephone, calls to your direct
line telephone number will not forward to this destination; they will forward to the direct line CF
destination - if activated. TOSHIBA IPedge UG 11/11...

Page 235 “Internal Call and Line Call” destinations. 2. Your telephone may forward even if
you do not activate Call Forward; this is because your system administrator has activated
System Call Forward on your telephone. TOSHIBA IPedge UG 11/11...

Page 236: Speed Dial

This is a view only screen. System Info Advisory messaging enables you to store an informative
message for LCD Display Advisory Messages telephones that call your telephone. This is view
only under System Info. TOSHIBA IPedge UG 11/11...

Page 237: Voice Mail

1f 1~16 is set, the DRL of the station will change to the DRL selected here when the station
dials the account code - in this case the DRL set for the station in Prg 200/260 etc.will be
overridden to the call. TOSHIBA IPedge UG 11/11...

Page 238: Preferences

1. Log into EMPA as a user. 2. Select Applications > Meeting. You have access to all Meeting
functions. Refer to the IPedge Meeting Audio and Web Conferencing User Guide or Help for
procedures on using the Meeting application. TOSHIBA IPedge UG 11/11...

Page 239 index A ~ C Index fixed, 13, flexible, account code, Hold, account codes,
navigation, forced, one touch, verified/non-verified, programmable, account number, Redial,
ACD, shift, ACD call ringing, speed dial, ACD key view, user programmable, ACD Keys, buttons
mode, ACT, action keys, action variables, calendar, actions...

Page 240 index D ~ K call handler mode, do not disturb call handler rules, 96, override, add
or change, Do-Not-Disturb, creating, door lock, delete, drag and drop, 100, call hold, drop, call
info DSS, export, DSS message, call pickup, 46, call waiting, calling, emergency calling from
SoftIPT, 34,...

Page 241 index L ~ P ACD, Msg button/LED, action, mute, 14, change, copy, DSS extension,
name, feature code, names initialize, storing speed dial, label, navigation key, PBX command,
Net Phone run program, expanded view, speed dial, main menu, swap, main screen, system,
shutdown, web,...

Page 242 Index R ~ W preferences user, tabs presence, advanced, privacy dialing, override,
docking, programmable keys, general, TAPI service provider, TASKE Contact, ready to dial,
testing actions, re-dial, tone signaling, redial, 15, transfer, 133, ringing trunk access code,
distinctive settings, two (tandem) CO line connection, line preference, ringing line preference,
run program,...
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This manual is also suitable for:

pedgelp5522-sdip
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